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Chapter 23: Repeat Tool

Repeat Tool 
What it does
Using this tool, you can create and edit repeat signs and text repeats (such as D.S. al Coda) in your 
score. These repeats can be defined for playback, if you wish, so that Finale, playing back your 
score, responds to them just as a musician would.

Use this tool to create first and second endings, functional Coda and D.S. symbols, and even end-
less repeats. You can also use the Easy Repeats or First Ending Repeats plug-ins to create repeats 
over a selected region. See EASY REPEATS PLUG-IN and FIRST ENDING REPEATS PLUG-IN in the 
Plug-ins section.

Special mouse clicks
• Click a measure that doesn’t contain a repeat sign to display the Repeat Selection dialog 

box, where you can create either a repeat barline or a text repeat to insert into the score (and 
define it for playback, if you wish).

• Click a measure that already contains a repeat sign to display a handle on every text repeat 
in the measure and a handle at the top and bottom of the repeat barline, if any. Double-click to 
display the Repeat Selection dialog box, where you can select an additional text repeat or 
repeat barline.

• Click a text repeat handle to select it; shift-click to select an additional one. Press delete, or 
right mouse click the handle and select Delete from the contextual menu to remove any 
selected text repeats.

• Drag a text repeat handle to move the text repeat in any direction (in all staves simulta-
neously).

• Click a repeat barline handle to select it; press delete, or right mouse click the handle and 
select Delete from the contextual menu to remove it.

• Drag a repeat barline bracket handle up or down to make the bracket taller or shorter (or, 
in the case of the open end of the bracket, drag left or right to lengthen or shorten the bracket). 
(If you want to drag the bracket so that it’s longer than a measure or so, double-click its han-
dle, select Individual Positioning, and click OK.)

• Double-click a text repeat handle, or right mouse click the handle and select Edit Repeat 
Definition from the contextual menu to display the Repeat Designer dialog box, where you 
can change the spelling, font, or justification of the text repeat.

• Double-click a repeat barline handle (or its bracket handle), or right mouse click the 
handle and select Edit Repeat Assignment from the contextual menu to display its Repeat 
Bar Assignment dialog box, where you can change the playback effects of the repeat barline.
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• Shift–double-click a text repeat handle, or right mouse click the handle and select Edit 
Repeat Assignment from the contextual menu to display the Repeat Assignment dialog 
box, where you can change the playback effects of the text repeat.

Metatools
You can create Repeat Metatools—one-key equivalents for repeat signs—that can save you time if 
you need to insert many repeat signs into your score.

To program a Repeat Metatool
Click the Repeat Tool. Press shift and a letter or number key. Finale displays the Repeat Selection 
dialog box; double-click the repeat barline or the text repeat you want to correspond to the letter 
or number you pressed (or, if the text repeat you want doesn’t appear in the list, click Create and 
design it at this point). Click OK.

To use a Repeat Metatool
Click the Repeat Tool. While pressing the letter or number key corresponding to the Metatool you 
programmed, click a measure. If the Metatool was programmed to insert a repeat barline, Finale 
displays the Backward Repeat Bar Assignment dialog box, where you can specify the playback 
effects of the barline (unless it was the purely graphic Forward Repeat barline). If the Metatool 
was programmed to insert a text repeat, Finale displays the Repeat Assignment dialog box, where 
you can specify the playback effects of the text repeat.

Contextual menus
Contextual menus are reached by right mouse-clicking on the handle of an object. A contextual 
menu will be displayed where you can select various items.

Repeat Selection dialog box
How to get there

Click the Repeat Tool x, and click a measure in the score. (If the measure already has a repeat, 

double-click.)

Repeat barline handles

Menu item What it does

Edit Repeat Assignment Display the Backward Repeat Assignment dialog box or the End-
ing Repeat Bar Assignment dialog box

Delete Removes selected repeat

Text Repeat handles

Menu item What it does

Edit Repeat Assignment Display the Repeat Assignment dialog box

Edit Repeat Definition Display the Repeat Designer dialog box

Delete Removes selected repeat
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What it does
In this dialog box, you can choose either a repeat barline or a text repeat you want to insert in the 
score. You can select one of the four repeat barlines pictured in the window.

• [The four graphic repeat icons]. The first icon, the Forward Repeat, is a purely graphic 
repeat barline. Normally, a musician relies upon such a barline to indicate the beginning of the 
repetition (the target measure). In Finale, however, this barline type has no playback functions 
of its own; that’s because you specify both the beginning and ending measures of the repeated 
section when you create the ending barline. 

Forward Repeat
(Graphic only)

Backward Repeat
(Graphic/Playback)

Backward Repeat
   with brackets
(Graphic/Playback)

Multiple Ending
       Repeat
(Graphic/Playback)
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The second icon, the Backward Repeat, can have a playback effect assigned to it: in other 
words, it can operate in the way you’d expect—by directing the playback flow back to an ear-
lier measure. Note, however, that like any of Finale’s repeats, it doesn’t have to direct playback to 
an earlier measure; you could define it to direct the playback to a later measure, if necessary.

The third icon, the Backward Repeat with Bracket, is identical to the Backward Repeat, except 
it has an adjustable bracket. You might use this barline to create a first ending, for example.

The fourth (rightmost) icon, the Multiple Ending Repeat bracket, offers a bracket alone. You 
can use this repeat bracket as the first measure of a two-measure first ending, or drag the right-
most handle toward the staff to create a final ending.
This repeat bracket has one significant difference from the other two functional graphic 
repeats. The two graphic Backward Repeats which contain barlines, jump to the specified tar-
get when the end of the measure is reached. In a measure containing a Multiple Ending Repeat 
Bracket, however, the playback jumps to the target when it reaches the beginning of the mea-
sure—once again, making this repeat bracket appropriate for the first measure of a first ending 
that’s several measures long.
To select one of these graphic repeats, double-click its icon. If you selected the first icon, you 
return to the score. If you selected either of the middle icons, you proceed to the Backward 
Repeat Bar Assignment dialog box. If you selected the rightmost icon, you go to the Ending 
Repeat Bar Assignment dialog box. See BACKWARD REPEAT BAR ASSIGNMENT DIALOG BOX 
and ENDING REPEAT BAR ASSIGNMENT DIALOG BOX for more information. For examples of 
how you might use these barlines in combination, see Installation & Tutorials, or REPEATS 
(BARLINES AND TEXT INDICATIONS).

• [Text Repeats]. In the scrolling display area of this dialog box, Finale lists any text repeats 
you’ve created in (or loaded into) your document. (To load a predefined Text Repeats Library 
into your document, see OPEN LIBRARY under the File Menu.)
A text repeat is a piece of text, such as “To Coda,” that functions as a fully operational repeat 
marking, just like a repeat barline. To create a new one, click Create; the Repeat Designer dia-
log box appears, where you can enter the text and define the appearance of the new text repeat. 
(You don’t define its playback effects until you actually place it in the score by double-click-
ing it in the Text Repeats list, whereupon the Repeat Assignment dialog box appears.)
For a more complete discussion of the options available when you’re creating a text repeat, see 
REPEAT DESIGNER DIALOG BOX. For details on defining the playback of a text repeat you’ve 
already created, see REPEAT ASSIGNMENT DIALOG BOX.

• Edit. To edit an existing text repeat, click it once and then click Edit. The Repeat Designer 
dialog box appears, where you can change any aspect of the appearance of the text repeat. 
(Note that when you edit any text repeat, the changes apply to every occurrence of it in the 
score.)

• Create. Click Create to design a new text repeat; the Repeat Designer dialog box appears. See 
REPEAT DESIGNER DIALOG BOX

• Duplicate. Click this button to create a duplicate of the selected Repeat Text Expression with 
the selected settings and attributes.

• Delete. After clicking a text repeat, click this button to remove it from the list of available text 
repeats.
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• Move Up • Move Down. Click these buttons to move the selected item or items up or down in 
the list.

• Cancel. Click Cancel to exit this dialog box without adding a repeat to your score.
• Select. Instead of double-clicking a repeat icon (or a text repeat), you can click it once and 

then click this button. You proceed to the score or to the next dialog box.

Repeat Assignment dialog box
How to get there

Click the Repeat Tool x, and click a measure. (If there’s already a repeat sign or text repeat in 

the measure, double-click.) When the Repeat Selection dialog box appears, double-click one of 
the displayed text repeats (if any). (If none appear, click Create to create your own; click OK, then 
double-click the new text repeat.)

If you’ve placed a text repeat in the score, you can also enter this dialog box by shift-double-click-
ing its handle.

What it does
A text repeat is a piece of text that functions as a fully operational repeat marking, such as “To 
Coda,” “D.S. al Coda,” and “D.C.” You can either design your own or use the ones in the Text 
Repeats Library provided with Finale, which you can load into your piece by choosing Open 
Library from the File Menu.

Once you’ve selected a text repeat by double-clicking it, this dialog box appears, in which you can 
define its playback effect. If you simply want it to appear as a graphic marking (with no playback 
function), just click OK without changing anything in the dialog box.
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• Repeat: (#). This indicator identifies the text repeat by number.

• Measure: (#). This indicator identifies the measure you clicked by number and the measure 
where the repeat will have it’s effect.

• Mark • Jumper. Select the radio button that describes the function of your text repeat, as fol-
lows: A Jumper directs playback to another measure or to another repeat defined as a Mark—
for example, to the coda. A repeat defined as a Mark doesn’t direct playback anywhere—in 
fact, it’s the target for a Jumper which has been set to jump to a Mark defined repeat. 
In other words, if you’re defining a text repeat to be a Jumper—one that says “To Coda,” for 
example—playback can be directed to a specific measure in the score, or to another text repeat 
defined as a Mark (the word “Coda,” for example). If you plan to use this method, where a text 
Jumper directs playback to a Mark, be sure to note the number ID of the Mark defined text 
repeat (as indicated by the “Repeat:” indicator at the top of this dialog box), because you’ll 
need to enter this number in the Target text box (see below) of the Jumper repeat.

• Target. The number in this text box is used when you’re designing a Jumper repeat. The num-
ber placed in this text box directs the flow of playback to either another measure or to a Mark-
defined text repeat. 
When the Measure radio button (see below) is selected, this text box indicates the measure 
number to which the text repeat should direct playback.
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When the Repeat radio button (see below) is selected, this text box indicates the Repeat ID 
number of a text repeat you have defined to be a Mark. Note: To make this method work you 
must have defined the selected text repeat as a Mark. If the Target number is zero, the text 
repeat will have no playback effect.

• Measure • Repeat. These radio buttons let you identify the number in the Target text box. If 
you click Measure, the number in the Target text box indicates the measure number to which 
the playback will jump when it encounters this text repeat. If you click Repeat, the number in 
the Target text box indicates the ID number of a Mark-defined text repeat to which the play-
back will jump when it encounters the text repeat you’re defining. Remember, a text repeat 
can direct the playback to any measure in the score, regardless of whether it occurs before or 
after the text repeat measure.
Note: these buttons, as well as the Target text box, have no effect when the Mark radio button 
in this dialog box is select (indicating this repeat is to be used as a Mark-defined text repeat 
and will have no playback-directing capability of its own).

• Always Jump. If you select this radio button, Finale will execute the repeat every time the 
playback reaches the text repeat—creating, in effect, an endless loop.

• Jump on Total Passes. If you select this radio button, Finale will only execute the repeat upon 
one particular repetition of the music (as specified by the number in the Total Passes text box). 
You might select this Repeat Action if the text repeat is “Last time to Coda,” for example.

• Repeat Until Total Passes. If you select this radio button, Finale will execute the repeat every 
time the playback reaches the text repeat until it’s been reached a specified number of times 
(the number in the Total Passes text box), after which it won’t repeat any more.

• Stop on Total Passes. If you select this radio button, Finale will execute the repeat every time 
the playback reaches the text repeat until it’s been reached a specified number of times (the 
number in the Total Passes text box), after which it will stop playback.

• Total Passes. The Total Passes text box lets you specify how many times the playback should 
reach the end of the text repeat measure (how high Finale should “count”) before Finale per-
forms the Repeat Action you’ve specified. (The number in the Total Passes text box has no 
effect, however, if you’ve selected Always Jump.)

• Multiple. There may be times when you’ll want the text repeat you’re designing to affect 
playback only on specific passes. For example, if the text repeat says “To Bridge 2nd and 4th 
times only,” indicating you want the playback to jump to the Target Measure (or the Mark-
defined text repeat) the second and fourth times through. Click the Multiple checkbox to enter 
the Multiple Total Passes for Repeat (#) dialog box, where you can, in effect, specify more 
than one Total Passes value. (In this example, you would enter 2 in the first text box and 4 in 
the next.) When you click OK and return to the Repeat Assignment dialog box, the Multiple is 
selected and the Total Passes text box is ignored. See MULTIPLE TOTAL PASSES FOR REPEAT 
(#) DIALOG BOX.

• Reset on Repeat Action. Once Finale has played the music the number of times specified in 
the Total Passes text box—and thus performed the Repeat Action—it will, if you wish, reset 
its internal “counter” back to zero and begin counting toward the Total Passes number again. 
This option could be useful if you’re creating nested repeats, and want an inner repeat to be 
fully executed with each pass of the larger repeated region.
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• Jump if Ignoring Repeats. Select this option on any repeat that you want taken uncondition-
ally if Finale is ignoring repeats. For example, you could set this at the beginning of a first 
ending repeat.

• Relative Jump. Select this option to indicate that Finale should add the number in the Target 
Measure text box to the current measure number to find the jump location, rather than treat the 
Target Measure number as an absolute measure number. Enter a negative number in the Target 
Measure text box for the number of measures you want Finale to jump back, and a positive 
number for the number of measures to jump forward. For example, if this option is selected 
and there’s a value of -8 in the Target Measure text box, Finale will jump back 8 measures 
from the current location.

• Individual Positioning. Finale usually places a text repeat in the same place in every staff. 
Click Individual Positioning to allow each staff’s text repeat to be independently movable.

• OK • Cancel. Click OK (or press enter) to confirm the settings you’ve made in this dialog box 
and place the new (or modified) text repeat in the score. Click Cancel to tell Finale to ignore 
any changes you made in this dialog box. You return to the score.

Backward Repeat Bar Assignment dialog box
How to get there

Click the Repeat Tool x, click a measure, then double-click one of the two middle graphic 

repeat icons (both of which are backward repeat barlines). Or, if a backward repeat barline is 
already in the score, double-click its handle.

What it does
The two middle graphic repeat barline icons (the Backward Repeat and the Backward Repeat with 
Bracket) aren’t just for display; they can also be defined to affect the playback of your piece. The 
way in which Finale performs this repeat and the measure to which it repeats are determined in 
this dialog box.
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• Measure: (#). This indicator specifies the measure in which the repeat barline will appear.

• Target Measure. The number in this text box specifies the measure Finale will jump to when 
playback reaches the repeat barline. Note that a repeat barline doesn’t necessarily direct the 
playback backward—the playback might jump to a later measure.

• Always Jump. If you select this radio button, Finale will execute the repeat every time the play-
back reaches the repeat barline—creating, in effect, an infinite loop.

• Jump on Total Passes. If you select this radio button, Finale will only execute the repeat upon 
one particular repetition of the music (as specified by the number in the Total Passes text box).

• Repeat Until Total Passes. If you select this radio button, Finale will execute the repeat every 
time the playback reaches the repeat barline until it’s been reached a specified number of 
times (the number in the Total Passes text box). Thereafter, it won’t execute the repeat (the 
barline will behave like a normal barline).

• Stop on Total Passes. If you select this radio button, Finale will execute the repeat every time 
the playback reaches the repeat barline until it’s been reached a specified number of times (the 
number in the Total Passes text box), after which it will stop playback.

• Total Passes. The Total Passes text box lets you specify how many times during playback 
Finale should reach the repeat barline (how high it should “count”) before performing the 
Repeat Action you’ve specified. (The number in the Total Passes text box has no effect, how-
ever, if you’ve selected Always Jump.)

• Reset on Repeat Action. Once Finale has played the music the number of times in the Total 
Passes text box—and thus performed the Repeat Action—it can be made to reset its internal 
“counter” back to zero and begin counting toward the Total Passes number again. This option 
could be useful if you’re creating nested repeats and want an inner repeat to be fully executed 
with each pass of the larger repeated region.
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• Individual Positioning. If you’ve selected the repeat barline with a bracket attached, Finale 
places an identical bracket in every staff. Click Individual Positioning to allow each staff’s 
bracket to be moved or resized independently. Note, too, that a bracket may be stretched hori-
zontally as long as needed—a useful fact to remember if you’re creating, for example, a first 
ending that’s four measures long.

• Relative Jump. Select this option to indicate that Finale should add the number in the Target 
Measure text box to the current measure number to find the jump location, rather than treat the 
Target Measure number as an absolute measure number. Enter a negative number in the Target 
measure text box for the number of measures you want Finale to jump back, and a positive 
number for the number of measures to jump forward. For example, if this option is selected 
and there’s a value of -8 in the Target Measure text box, Finale will jump back 8 measures 
from the current location.

• OK • Cancel. Click OK (or press enter) to confirm the settings you’ve made in this dialog box 
and place the repeat sign in the score (if it wasn’t there already). Click Cancel to tell Finale to 
ignore any changes you made in this dialog box and return you to the score, and no repeat sign 
is placed (or, if you were editing an existing repeat, no changes take place).

Ending Repeat Bar Assignment dialog box
How to get there

Click the Repeat Tool x, and click a measure. The Repeat Selection dialog box appears. Dou-

ble-click the rightmost repeat barline icon (the Multiple Ending repeat bracket). If the measure 
already has a repeat bracket, click in the measure once, then double-click the handle of the repeat 
bracket.

What it does
The Multiple Ending Repeat bracket is the only one of Finale’s functional graphic repeats which 
makes playback jump to a specified measure when the playback reaches the beginning of the mea-
sure. This characteristic makes it ideal for the beginning of a first ending, for example. Don’t let 
the appearance of this barline’s bracket (it’s open at the right end) confuse you; though it appears 
to be a “first ending” bracket, it’s also very useful as a second ending (you can always change the 
bracket’s shape once it’s in the score). In this dialog box, you can specify various elements of 
behavior and appearance in the score.
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• Ending Text (Optional). Any text you enter here will appear under the bracket when the 
bracket appears in the score. If you don’t type anything, Finale will automatically use the 
number in the Total Passes (or Multiple Total Passes) text box. If you want to combine the 
Total Passes number with other text (for example, “4th time only”), use the number sign (#, 
which you create by typing shift-3) as a stand-in for the Total Passes number (for example, 
“#th time only”).

You set the font for this text by choosing Select Default Fonts from the Options Menu and 
clicking the Ending Repeat from the text drop-down list.

• Target Measure. In this text box, enter the number of the measure to which you want the 
playback to jump (when it reaches this repeat bracket). You’ll usually want the music to jump 
to a later measure in the score, but you can enter any measure’s number here. If you leave zero 
in this text box, the repeat won’t have any playback function at all.

• Total Passes. The number in this text box tells Finale how many times to play the bracketed 
measure instead of jumping. If you’re creating a first ending, for example, the Total Passes 
would be 1; on subsequent passes, Finale will direct playback to the Target Measure (which 
could be, for example, a second ending).

• Individual Positioning. If your piece contains more than one staff, Finale will place an iden-
tical ending-repeat bracket in each staff; all brackets will be affected when you resize or alter 
any one. If you want each bracket to be independently resizable and movable, select Individ-
ual Positioning.

• Jump if Ignoring Repeats. Select this option on any repeat that you want taken uncondition-
ally if Finale is ignoring repeats. For example, you could set this at the beginning of a first 
ending repeat.

• Relative Jump. Select this option to indicate that Finale should add the number in the Target 
Measure text box to the current measure number to find the jump location, rather than treat the 



Multiple Total Passes for Ending dialog box 23-12      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

Target Measure number as an absolute measure number. Enter a negative number in the Target 
measure text box for the number of measure you want Finale to jump back, and a positive 
number for the number of measures to jump forward. For example, if this option is selected 
and there’s a value of -8 in the Target Measure text box, Finale will jump back 8 measures 
from the current location.

• Multiple. Click the Multiple checkbox to enter the Multiple Total Passes for Ending dialog 
box, where you can, in effect, specify more than one Total Passes value; in the text boxes, 
enter the numbers corresponding to the passes when you want the bracketed measure played. 
See MULTIPLE TOTAL PASSES FOR ENDING DIALOG BOX.

There may be situations where you want Finale to play an ending several times. For example, 
if this is a “1, 3, 5.” ending, you’d want Finale to play the bracketed measure the first, third, 
and fifth times through, and you’d want the playback to jump to the Target Measure the second 
and fourth times through. In this example, you would enter 1 in the first text box, 3 in the sec-
ond, and 5 in the third.

When you click OK and return to the Ending Repeat Bar Assignment dialog box, the Multiple 
checkbox is selected and the Total Passes text box is ignored.

Provided you didn’t type anything into the Ending Text text box, Finale will automatically put 
the appropriate numbers—separated by commas—under the bracket when it appears in the 
score. In the example above, “1, 3, 5” would appear under the bracket.

• OK • Cancel. Click OK (or press enter) to return to the score, where the new (or edited) 
repeat barline appears. Click Cancel to tell Finale to ignore any changes you made in this dia-
log box and return you to the score.

Multiple Total Passes for Ending dialog box
How to get there

Click the Repeat Tool x, and click a measure. When the Repeat Selection dialog box appears, 

double-click the Multiple Ending repeat bracket icon (the rightmost icon). Click Multiple. If 
there’s already a Multiple Ending repeat bracket in the measure, click in the measure. Then, dou-
ble-click the Multiple Ending repeat bracket’s handle.

What it does
In general, you use the Multiple Ending repeat bracket as the first measure of, for example, a first 
ending. When Finale plays back the repeated section a second time through, this barline is respon-
sible for directing playback to the second ending (or any other place in the score).

However, there may be times when you’ll want the playback to jump to another ending only on 
specific passes. For example, if this is a “1, 3, 5.” ending, you’d want the playback to jump to the 
target measure (or target Mark-defined text repeat) only the second and fourth times through. In this 
dialog box, you can specify which times the Multiple Ending measure is to be played.
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• «    ». Click these right and left arrow buttons to scroll through the text boxes to specify more 
than four passes.

• [Text boxes]. In each text box, enter a number corresponding to the repetition of the music on 
which you want Finale not to jump to another measure—in other words, specify which times 
the music should play this measure. For example, if you want Finale to jump to the second 
ending only the fourth time it encounters this measure, creating a “1, 2, 3.” ending—enter 1, 2, 
and 3 in the first three text boxes.

• Clear. Click Clear to enter zeros in all the text boxes. If you now click OK, you’ll return to the 
Ending Repeat Bar Assignment dialog box, where there’s no longer a mark in the Multiple 
checkbox.

• OK • Cancel. Click OK (or press enter) to confirm your Multiple Total Passes settings. You 
return to the Ending Repeat Bar Assignment dialog box, where the Multiple checkbox is now 
selected and any number in the Total Passes text box is ignored. Click Cancel to return to the 
Ending Repeat Bar Assignment dialog box without changing the status of the Multiple Total 
Passes settings.

Multiple Total Passes for Repeat (#) dialog 
box
How to get there

Click the Repeat Tool x, and click a measure. (If there’s already a graphic barline repeat sign 

or text repeat in the measure, double-click the measure.) When the Repeat Selection dialog box 
appears, double-click one of the displayed text repeats (if any). (If none appears, click Create to 
create your own; click OK, then double-click the new text repeat.) Click Multiple. See REPEAT 
SELECTION DIALOG BOX

If you’ve placed a text repeat in the score, you can also enter this dialog box by shift–double-
clicking its handle, then clicking Multiple.

What it does
There may be times when you’ll want the text repeat you’re designing to affect playback only on 
specific passes. For example, if the text repeat says “To Bridge (1st and 3rd times only),” you’d 
want the text repeat to have no playback effect the second and fourth times through. In this dialog 
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box, you can, in effect, specify more than one Total Passes value (see REPEAT ASSIGNMENT DIA-

LOG BOX for a detailed description of total passes).

• «    ». Click these right and left arrow buttons to scroll through the text boxes if you want to 
specify more than four passes.

• [Text boxes]. In each text box, enter a number corresponding to the repetition of the music on 
which you want the Repeat Action to be performed. For example, if you want Finale to jump 
“To Bridge” only on the first and third repetitions of the music, enter 1 in the first text box and 
3 in the second.

• Clear. Click Clear to enter zeros in all the text boxes. If you now click OK, you’ll return to the 
Repeat Assignment dialog box, where there’s no longer a mark in the Multiple checkbox.

• OK • Cancel. Click OK (or press enter) to confirm your Multiple Total Passes settings. You 
return to the Repeat Assignment dialog box, where the Multiple checkbox is now selected and 
any number in the Total Passes text box is ignored. Click Cancel to return to the Repeat 
Assignment dialog box without changing the status of the Multiple Total Passes settings.

Repeat Designer dialog box
How to get there

Click the Repeat Tool x, and click a measure. (If there’s already a graphic repeat sign or text 

repeat in the measure, double-click.) When the Repeat Selection dialog box appears, click Create.

If you’ve placed a text repeat in the score, you can also enter this dialog box by double-clicking its 
handle.

What it does
In this dialog you create a text repeat which can function as a fully operational repeat marking, 
such as “To Coda,” “D.S. al Coda,” and “D.C.” Here you write your own text and specify the font 
and justification for the repeat.

If you prefer, you can use predefined text repeats in the Text Repeats Library (Text Repeats.LIB) 
provided with Finale. See OPEN LIBRARY.)

Note that this dialog box defines only the text itself and appearance of the text repeat (font and 
positioning specifications); to define its playback effects, you have to access the Repeat Assign-
ment dialog box (see REPEAT ASSIGNMENT DIALOG BOX).
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• Repeat Text. Enter the text for the repeat marking itself in this text box. The characters in this 
text box are displayed in the System font, regardless of the actual font you’ve chosen.

• Replace ‘#’ with Total Passes. When you type #, (or shift-3) in the Repeat Text text box and 
select this option, the ‘#’ sign is a stand-in for the number in the Total Passes text box. When 
the text repeat appears in the score, Finale will display the Total Passes number instead of #. 
(You specify the Total Passes in the Repeat Assignment dialog box, which appears when you 
place the text repeat in the score.) See REPEAT ASSIGNMENT DIALOG BOX.

For example, you might want your text repeat to say “Jump to Coda #th Time Only”; when the 
mark appears in the score, it will read “Jump to Coda 4th Time Only” (substituting the number 
you’ve indicated in the Total Passes text box).

• Replace ‘#’ with Repeat Mark in Target. When you type #, (or shift-3) in the Repeat Text 
text box and this radio button is selected, the ‘#’ sign is a stand-in for the actual text of a 
Mark-defined text repeat.

To make the Mark-defined repeat appear in the score, select a Jumper-defined text repeat from 
the Repeat Selection dialog box. Once in the Repeat Assignment dialog box, make sure the 
Jumper and Repeat radio buttons are selected. In the Target text box, select a Mark-defined 
text repeat ID number, and click OK. Finale will then display the text of the target Mark 
instead of #. See REPEAT ASSIGNMENT DIALOG BOX for a more complete discussion on defin-
ing a repeat as a Mark or a Jumper.

For example, you could create the text repeat: “Last time to #.” When you place this Jumper-
defined text repeat in the score, from the Repeat Assignment dialog box, you specify that this 
Jumper should direct playback to a Mark-defined text repeat (“Coda,” for example) whose ID 
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number you enter in the Target text box. When this text repeat appears in the score, it will say 
“Last time to Coda,” because Finale substitutes the word “Coda” for the # sign. (See CODA for 
step-by-step instructions.)

• Use This Font. If you select this option, the entire text repeat you’re designing will appear in 
the font you’ve selected (by clicking the Set Font button). If you don’t select this option, how-
ever, the Mark-defined text repeat you’re incorporating into this text repeat will appear in its 
own font, regardless of the font you’ve set for the text repeat you’re designing.

• Replace ‘#’ with Measure Number in Target. When you type  #, (or shift-3) in the Repeat 
Text text box and select this option, the ‘#’ sign is a stand-in for the measure number of the 
measure to which this Jumper-defined text repeat will direct playback. When the text repeat 
appears in the score, Finale will substitute the measure number in place of the # sign.

For example, you might type “Last time to m. #.” When this text repeat appears in the score, it 
will read “Last time to m. 44” (substituting whatever measure number you’ve designated as 
the Target in the Repeat Assignment dialog box).

• Enclose Repeat. When you click this checkbox, the Enclosure Designer dialog box appears, 
in which you can choose a geometric shape to enclose your text repeat. See ENCLOSURE 
DESIGNER DIALOG BOX.

• Set Font. Click this button to display the Font dialog box, in which you can set the font for 
your text repeat.

• Justification: Left • Right • Centered. Click the radio button corresponding to your choice of 
the text repeat’s alignment in the measure: flush with the left barline, flush with the right bar-
line, or centered between the barlines. Note that the Horizontal and Vertical Offset will affect 
the final position of your text repeat.

• Horizontal Offset • Vertical Offset. The numbers in these text boxes adjust the position of the text 
repeat horizontally relative to its default position (as specified by your Justification selection) and 
vertically relative to the top staff line. A positive number in the Horizontal Offset text box moves the 
text repeat to the right; a positive number in the Vertical Offset text box moves it upward. Remem-
ber, however, that you can always adjust the position of a text repeat manually by dragging its handle 
when you return to the score.

• OK • Cancel. Click OK (or press enter) to confirm the creation of your new text repeat. You 
return to the score, or to the Repeat Selection dialog box, where the new text repeat appears in 
the list. Click Cancel to return to the Repeat Selection dialog box (or to the score) without cre-
ating or editing a text repeat.

Repeat Bars dialog box
How to get there
From the Options Menu, choose Document Settings, then Repeat Bars. 

What it does
The Repeat Bars dialog box provides a number of powerful options that enable you to define glo-
bal settings for repeats. The changes you make affect the appearance of all repeat bars in your 
score. You can set the thickness of both thin and thick lines of a repeat, tell Finale how much space 
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to leave between repeat lines or between lines and dots, and draw repeats that have curved, single, 
or double “wings”. You can also set the amount of space to leave before a forward repeat that is 
placed after a starting clef, or a key or time change. You can define the appearance of repeat dots 
and position them in relation to the repeat, independently of each other. Finale also offers three 
choices of back-to-back repeat styles.

• Wing Styles: None • Curved • Single • Double. Click to select a wing style for all repeat bars 
in your score.

• Back-to-Back Styles: Thin • Mixed • Thick. Click to select a style for back-to-back repeats 
in your score, using thin lines, a mixture of thin and thick lines, or only thick lines. 

• Line Options: Heavy Line Thickness. Enter the line thickness (in measurement units) of the 
thick lines used in repeat bars. This setting affects the thick lines in all repeats currently in 
your score, as well as those not yet created.

• Line Options: Thin Line Thickness. Enter the line thickness (in measurement units) of the 
thin lines used in repeat bars. This setting affects the thin lines in all repeats currently in your 
score, as well as those not yet created.
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• Line Options: Space Between Lines. Enter a value (in measurement units) to set the distance 
between the thin and thick lines in repeat bars.

• Forward Repeat Spacing: After Clef • After Key • After Time. These three new controls 
ensure that enough space appears before forward repeat bars in your score. Enter a positive 
value (in measurement units) to change the distance between forward repeats and any starting 
clefs, or key or time signatures at the start of staff systems.

• Space Between Dot and Line: Forward Repeat • Backward Repeat. These settings enable 
you to position a repeat dot horizontally in relation to the thin line of a repeat. Enter a value in 
Forward Repeat (in measurement units) to set the horizontal spacing between a dot and the 
thin line in a forward repeat. As the value increases, so does the distance between the dot and 
the line. Enter a value in the Backward Repeat text box (in measurement units) to set the hori-
zontal spacing between a dot and the thin line in a backward repeat. As the value increases, so 
does the distance between the dot and the thin line.

• Vertical Dot Adjustment: Upper Dot • Lower Dot. By default, Finale places repeat dots ver-
tically in the center of the spaces above and below the middle line of the staff for the Upper 
and Lower Dot respectively. These settings allow you to vertically reposition dots in relation 
to their default positions. Enter a positive value (in measurement units) to raise the upper or 
lower dot above its default position. As the value increases, the dot moves higher up the staff. 
Entering a negative value moves the dot below its default position. As the negative value 
increases, the dot moves further down.

• Dot: Select. Click Select to choose the character used for the repeat dots.

• OK • Cancel • Reset. Click OK to save new settings and return to the score. Click Cancel to 
cancel any changes you made to the settings, or click Reset to restore the built-in Finale 
default settings.

Repeat Endings dialog box
How to get there
Choose Repeat Endings from the Document Settings submenu in the Options Menu to display the 
Repeat Endings dialog box.

What it does
The Repeat Endings dialog box increases your control over how Finale places ending repeat 
brackets and numbers in your score. You can specify global values for the bracket height, the 
length of the hook, the thickness of the bracket line, the distance to indent the bracket, and the 
position of the bracket number.
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• Height of Bracket. Enter a value in the current measurement units to set the height of the hor-
izontal line of ending repeat brackets, measured from the top line of the staff. As the value 
increases, so does the bracket’s distance from the top staff line. 

• Length of Front Hook • Length of Back Hook. Enter a value in the current measurement 
units for the length of the ending repeat bracket’s front and back hooks (the short vertical line 
of the bracket). As the value increases, so does the length of the hook. 

• Line Thickness. Enter a value in measurement units to set the thickness of the ending repeat 
bracket lines.

• Inset for Start of Bracket. This setting measures the distance between the start of the bracket 
(in measurement units) and the first barline in a measure. The default starting inset is zero, 
which positions the bracket at the first barline of the measure. Enter a positive value to move 
the start inset to the right. This shortens the bracket. Enter a negative value to move the start 
inset to the left. This stretches the bracket, extending it into the preceding measures.

• Inset for End of Bracket. This setting measures the distance between the end of the bracket 
(in measurement units) and the ending repeat symbol. The bracket’s default ending inset is 
zero, which positions the end of the bracket at the ending repeat. Enter a positive value to 
move the end inset to the left. This shortens the bracket. Enter a negative value to move the 
end of the bracket to the right of the ending repeat, lengthening the bracket and extending it 
into the following measures.

• Ending Repeat Text: Horizontal • Vertical. These settings determine where Finale places 
the text for an ending repeat, measured horizontally from the bracket hook, and vertically 
from the end of the bracket hook. 

Enter a positive value (in measurement units) in the Horizontal text box to set the text’s horizontal 
distance from the start of the bracket. As the value increases, Finale moves the text further to the 
right. As the value decreases, the text moves further to the left. Enter a positive value in the Vertical 
text box to set the text’s vertical distance from the end of the bracket hook (in measurement units). 
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As the value increases, Finale moves the text higher. As the value decreases, the text is lowered. This 
setting affects the appearance of all ending repeats already in the score, as well as those yet to be 
placed in the score.

• Reset • Cancel • OK. Click Reset to restore the built-in Finale default settings. Click Cancel 
to cancel any changes you made to the settings, or click OK to save new settings and return to 
the score.

Easy Repeats Plug-in
How to get there

Select the section to be repeated with the Mass Mover Tool. Click on the Plug-ins Menu, then 

choose Repeats, then Easy Repeats. See PLUG-INS MENU for more information on plug-ins.

What it does
The Easy Repeats plug-in allows you to easily place a repeat in the selected region. Use the Mass 
Mover Tool (or any other tool that allows you to select a region such as Key or Time Signature 

Tools) to select a region and then select Easy Repeats from the Plug-ins Menu. Easy Repeats sim-

ply surrounds the current selection with functional begin and end repeat marks:
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Notes
• The Easy Repeats and First Ending Repeats plug-ins are part of the same plug-in.

• Both Easy Repeats and First Ending Repeats respect all of your document settings for repeat 
marks and ending brackets. This means that ending brackets will be drawn over all staves 
(except for those staves which have the Endings and Text Repeats check box deselected in the 
Items to Display group in the Staff Attributes Dialog). The shapes of the repeat bar lines and 
ending brackets are specified in the Repeat Bars Dialog and Repeat Endings Dialog (both 
accessible from the Document Options hierarchical submenu in the Options Menu).

• If the first measure of a document is included in a selection for which either the Easy Repeats 
or the First Ending Repeats commands is invoked, a forward repeat bar will be drawn at the 
beginning of the score. This is not the practice recommended in standard texts on notation, but 
would be common for repeated exercises, etc. If you do not wish to have a forward repeat at 
the first measure, you can delete it manually with the Repeat Tool.

Before:

After:
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First Ending Repeats Plug-in
How to get there

Select the entire section to be repeated with the Mass Mover Tool. Click on the Plug-ins Menu, 

then choose Repeats, then First Ending Repeats. See PLUG-INS MENU for more information on 
plug-ins.

What it does
The First Ending Repeats plug-in allows you to easily place a repeat with multiple endings in the 
selected region.  The First Ending Repeats dialog allows you to specify the number of measures 
under the ending bracket. You can also optionally specify more than two passes through the 
selected region. Be sure to read the Notes section under Easy Repeats.  It applies to both Easy 
Repeats and First Ending Repeats. See Notes.

In playback the selected region will be performed three times.

• Total Passes. Specify the number of times the selected region will be performed. You can 
either type in the desired numbers or use the arrows next to the fields to increment or decre-
ment the current values. For example, it you place a 3 in this text box, “1, 2” will be placed 
under the repeat bracket.

• Measures under Ending Bracket. Specify the number of measures to be included in the end-
ing (counting back from the last measure). The measures under the ending bracket will not be 
performed in the final pass through the selected region; instead the music jumps to the first 
measure after the selection. You can either type in the desired numbers or use the arrows next 
to the fields to increment or decrement the current values. 

The number of measures under the ending bracket must be less than the total number of mea-
sures in the current selection. You may specify a value of 0 for the length of the ending 
bracket; in this case no ending bracket will be added and the entire selection will be performed 
in each pass through the music (including the final one). The result of the above settings would 
look like the example below.
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• OK • Cancel. Click OK to create a repeat with the specified settings. Click Cancel to return to 
the score without making any changes.

Repeats (barlines and text indications)
Repeat barlines in Finale may be either purely graphic, or fully functional for playback. For a full 
tutorial in the use of the Repeat Tool, see Installation & Tutorials. See also FIRST ENDINGS and SEC-

OND ENDINGS; and  EASY REPEATS and FIRST ENDING REPEATS plug-ins.

Repeats can be nested (endings within endings) or infinite. They can also be text repeats—instead 
of a repeat barline, you can create an expression such as D.S. al Coda, which will actually affect 
playback. See CODA; D.S., D.S. AL CODA; and D.C.

To place a repeat in your score

• Click the Repeat Tool x; then click the measure you want to contain the repeat. The 

Repeat Selection dialog box appears. (Note: If you wish to create a text repeat—“To Coda,” 
for example—see: REPEAT SELECTION DIALOG BOX—[TEXT REPEATS].) See REPEAT SELEC-

TION DIALOG BOX for more a more detailed description.

• Double-click the desired graphic repeat icon or text repeat. If you’re placing the Forward 
Repeat barline (leftmost graphic icon—purely graphic), it now appears in the score, and your 
task is complete. If you selected one of the other three icons or a text repeat, one of three dia-
log boxes appear, asking for details about the playback definition of this repeat barline. See 
the BACKWARD REPEAT BAR ASSIGNMENT, ENDING REPEAT BAR ASSIGNMENT, and REPEAT 
ASSIGNMENT DIALOG BOXES for more information. If you don’t intend to use this barline’s 
playback function, click OK and your task is completed.

• For playback, enter the target measure number in the Target Measure text box. If you 
are entering a graphic repeat which allows for playback, type the measure number in the text 
box. The Target Measure is the measure Finale should jump back to. (Note, however, that the 
Target Measure technically doesn’t have to be an earlier measure.)

If you are entering a text repeat, you have more options for how you want your repeat to func-
tion. Select the Measure radio button if you want your repeat to go to a select measure, select 
the Repeat radio button if you want your repeat to jump to a Mark-defined repeat. See the 
REPEAT ASSIGNMENT DIALOG BOX for more details.
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• Specify the desired Repeat Action. This option, available only for text repeats and the Back-
ward Repeat barline icons, tells Finale what to do when it has played the measure the number 
of times specified in the Total Passes text box (below). Always Jump ignores the Total Passes 
completely, and jumps to the Target Measure every time. Jump on Total Passes executes the 
repeat only on the “pass” you specify. (Jump on Total Passes is ideal for a Last time to Coda 
marking.) Repeat Until Total Passes is just the opposite—it executes the repeat every time the 
repeat barline is encountered, until the measure has been played the number of times specified 
in the Total Passes text box. (Repeat until Total Passes is appropriate for standard repeats, such 
as first endings.)

• In the Total Passes text box, specify the number of times the playback should reach the 
repeat barline (how high Finale should “count”) before performing the Repeat Action 
you’ve specified (see above). If you have selected jump on total passes for a graphic back-
ward repeat barline or a text repeat, the number you indicate will ignore the repeat until the 
measure has been played the number specified in the total passes text box. If you have selected 
Repeat until Total Passes, the repeat action will be executed every time it reaches the end of 
the measure.

 If you have selected the Multiple Ending Bracket—the rightmost icon—it’s easy to calculate 
the Total Passes: it’s the same number displayed under the bracket, which you typed into the 
Ending Text text box. If, for example, if it’s a first ending, the Total Passes is 1. If it’s a first, 
third, and fifth ending, click Multiple, and type 1, 3, and 5 into the text boxes.)

• Click Individual Positioning, if desired. If you’ve selected a text repeat or a repeat barline 
with a bracket attached, Finale usually places the repeat in the same position in every staff. 
This option allows the text repeat or the bracket to be moved or resized independently.

• Press enter. The repeat barline now appears in your score.

To move, hide, or delete a text repeat

• Click the Repeat Tool x; then click the measure in which the mark appears. Its handle 

appears.

• Drag the handle to move the sign; select it and press delete to remove it. Note that in terms 
of its playback functions, the marking is still associated with the measure in which you origi-
nally placed it, even if you drag it to a different measure.

Repeat markings initially appear in all staves. To hide the marking in a certain staff, click the 
Staff Tool; then double-click the desired staff. In the dialog box that appears, click Endings 
and Text Repeats. Click OK.

To adjust the brackets on, or delete, a repeat barline

• Click the Repeat Tool x; then click the measure in question. Three handles appear on 

the bracket. If you’re adjusting a text repeat, a single handle appears.

• To stretch a bracket, drag its upper handles vertically or horizontally. To delete a repeat 
(barline or text), click the bottom handle and press delete. You can’t stretch a bracket fur-
ther than the length of one system. You can, however, make brackets appear to be longer by 
combining two repeat barlines on each system. See FIRST ENDINGS.



Repeats (barlines and text indications) 23-25      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

To change the default bracket height for repeats (and set the number font)
• Choose Select Default Fonts from the Options Menu. The Select Default Fonts dialog box 

appears.

• To change the font for the numbers that appear in a repeat bracket (for example, the “2.” 
in a second ending bracket), choose Select Default Fonts from the Options Menu. Select 
Ending Repeats from the Text drop-down list. 

• To change the height of any brackets in your score, select the Repeat Endings from the 
Document Settings submenu of the Options Menu. Change the Height of Bracket num-
ber. The units are whatever you’ve selected using the Measurement Units command (Options 
Menu).

To change a repeat barline’s playback definition

• Click the Repeat Tool x; then click the measure in question. Handles appear at the 

ends of the bracket and the barline.

• Shift–double-click any handle. The Bar Assignment (playback definition) dialog box reap-
pears. Make the desired changes, and then click OK (or press enter). (See “To place a repeat in 
your score,” for the playback options you can specify.)

To break a repeat barline that connects staves
When you create a repeat barline, it’s ordinarily drawn as a solid line across the space between 
any grouped staves (those connected by a bracket, for example). If you prefer, you can instruct 
Finale not to draw the barline continuously through the space between staves.

• Click the Staff Tool s, and double-click the staff that’s just below the space where 

you want to omit the barline. The Staff Attributes dialog box appears.

• Select Break Repeat Barlines Between Staves. Click OK. 

To hide the ending brackets and text repeats for a specified staff
If your score includes a piano part (for example), you normally won’t want ending brackets (such 
as a first ending bracket) to appear above both the treble and bass staves. Similarly, you would 
probably want a Text Repeat (such as “To Coda”) only to appear above the treble staff, not above 
both.

• Click the Staff Tool s, and double-click the staff for which you want to hide the 

brackets or Text Repeats. The Staff Attributes dialog box appears.
• In the Items to Display section, deselect Endings and Text Repeats. Click OK. 
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First endings
See also SECOND ENDINGS.

You create a first ending with the Repeat Tool; it can be purely graphic or it can be functional, accu-
rately directing the MIDI playback.

If you decide to create a functional first ending, you’ll have to create two “repeats,” as shown here.

To create a first ending

• Click the Repeat Tool x; then click the first ending measure. If the first ending is 

longer than one measure, click the last measure of it. The Repeat Selection dialog box 
appears.

• Double-click the Backward Repeat with Bracket icon (the third icon). The Backward 
Repeat Bar Assignment dialog box appears, asking for details about the playback definition of 
this repeat barline. If you don’t intend to use this barline’s playback function, skip the next 
two instructions.

• Enter the target measure number in the Target Measure text box. The Target Measure is 
the next measure played after the first ending—in other words, it’s the measure to which 
Finale should jump back. (The Target Measure technically doesn’t have to be an earlier mea-
sure.)

• Click Always Jump. You selected the Always Jump option because the repeat you’re design-
ing will, strictly speaking, only have its playback effect the first time the music reaches it 
(thereafter, the playback flow skips over it). The point is that you don’t really want this barline 
to Always Repeat the music; but, in fact, after the first time through, Finale won’t encounter 
this barline again.

• Click OK (or press enter). You’ve created the “right end” of the first ending—the one that 
directs the playback flow back to the beginning (or some other designated spot). Now you 
need to create the beginning repeat (shown at right in the figure above), which will direct play-
back to the second ending.

• Double-click the first ending measure. If the first ending is more than one measure long, 
click the first measure of it. The Repeat Selection dialog box appears.

• Double-click the Multiple Ending Repeat (the icon on the right). The Ending Repeat Bar 
Assignment dialog box appears. If you don’t intend to use this barline’s playback function, 
skip the next two instructions.

• Enter the measure number of the second (or final) ending in the Target Measure text 
box. When the playback reaches the beginning of the measure you clicked, it will jump to the sec-
ond ending.

1.

First repeat barline
(sends playback to beginning)

1. 2.

Second  repeat barline
(sends playback to 2nd ending)

2.
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• In the Total Passes text box, type 1. You entered a 1 because you want Finale to play the ending 
only once (the first time); thereafter, the playback will jump to the second ending. The number 
you enter in the Total Passes text box is also the number that will appear under the first ending 
bracket in the score (like this: “1”). If you want to specify some other text to appear under the 
bracket—for example, if you prefer a period after the ending number, like this: “1.”—enter it 
in the Ending Text text box (both number and period). If this is a first, second, and third end-
ing, click Multiple. A dialog box appears, letting you specify multiple Total Passes values—in 
this example, 1, 2, and 3. Once again, Finale will automatically place these numbers under the 
first ending bracket in the score (separated by commas, like this: “1, 2, 3”), unless you’ve 
entered text in the Ending Text text box.

• Click OK (or press enter). Both “repeats” are in your score. If you drag the square handles 
carefully, you can align the open ends of the two brackets so that they appear to be a continu-
ous horizontal bracket, as shown below.

By dragging the handles of the repeat bracket in each measure (top), you can adjust the brackets’ 
heights so that they appear to be a single continuous bracket (bottom). Note that you can eliminate 
the “hook” of the left repeat bracket by dragging the lowest handle upward. (You may have to 
adjust the handle on the numeral to compensate.)

Second endings
See also FIRST ENDINGS.

The second ending (in the sense of being the final ending from a set of repeats) is purely graphic. 
If you create a playback-functional first ending, the second ending needs no playback definition.

To create a second-ending bracket

• Click the Repeat Tool x. Click the first measure of the second ending. The Repeat 

Selection dialog box appears. Four repeat icons appear at the top of the dialog box.
• Double-click the rightmost icon (the Multiple Ending Repeat barline). The Ending Repeat 

Bar Assignment dialog box appears.
• Enter the text that is to appear under the bracket. If this is a second ending, you’ll proba-

bly want to type “2.” into the text box. Since this is a nonfunctional repeat barline (graphic 
only), leave the other options in this dialog box alone.

.

.

œ
œ
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˙
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• Click OK (or press enter). To adjust the bracket, drag either of the upper handles in any 
direction. To delete the repeat barline (bracket and all), click its bottom handle and press 
delete.

To create a closed ending bracket

• Click the Repeat Tool x. Click the first measure of the closed ending. The Repeat 

Selection dialog box appears. Four repeat icons appear at the top of the dialog box.
• Double-click the rightmost icon (the Multiple Ending Repeat barline). The Ending Repeat 

Bar Assignment dialog box appears.
• Enter the text that is to appear under the bracket. If this is a fine ending, you’ll could type 

“fine” into the text box. You could also select Stop on Total Passes, and enter 1 in the Total 
Passes text box to stop when the playback reaches this ending.

• Click OK (or press enter). To close the bracket, drag the upper rightmost handle down to the 
staff. To delete the repeat barline (bracket and all), click its bottom handle and press delete. If 
there are more measures to the closed ending, repeat these steps for each measure and adjust 
the brackets accordingly with the handles provided.

Coda
See also D.S., D.S. AL CODA.

A coda is a musical tag, or extension, which usually follows the main body of the piece. The 

musician’s cue to jump to the coda is often marked by a marking like “To coda fi,” and the coda 

itself often displays a notation like “fi Coda.” 

You can place such markings into your score very easily if you’re preparing your score for print-
out but not for playback.

With some additional steps, you can even make your coda markings functional—that is, they can 
actually control the way Finale plays back your score. When Finale encounters the “To Coda” 

marking, it can automatically direct the playback of your score to the measure displaying the fi 
sign.

To place the coda sign, and a “to coda” sign in the score

•  Click the Repeat Tool x. Click the measure in which you want the coda sign to 

appear. The Repeat Selection dialog box appears. If you’ve loaded a Text Repeat Library—or 

if the Finale Maestro Font Default file is in place—you should see the fi sign.

If you don’t see the marking, click Create; the Repeat Designer dialog box appears. While 
pressing alt, type 0222. Click Set Font, and set the font to Maestro 24 point. Press enter twice.

• Double-click the fi sign. You arrive at the Repeat Assignment dialog box. If you are not plac-
ing a “working” coda sign in you piece, click OK, and your task is complete, otherwise, con-
tinue following the instructions.
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• Note the Repeat number of the fi mark. This indicator appears at the top of the dialog box, 
in the form “Repeat: 1” (or whatever number Finale has assigned to your coda sign). You’ll 
need to remember this number for a moment.

• Click Mark. You’ve just defined this text repeat to be a mark—in other words, a marker to 
which Jumper text repeats (“To Coda,” in this example) will direct playback.

Tip: Check Individual Positioning to allow the coda sign to be moved independently between 
staves.

• Click OK (or press enter). The coda sign appears in all staves. See “REPEATS –To move, 
hide, or delete a text repeat.

Once you’ve created a coda symbol and designed it for playback, you must now place the “To 
Coda” sign somewhere in the main body of music. Follow these steps, to create a functional text 
repeat that directs the playback of your score to the measure containing the coda sign.

• Click the Repeat Tool x. Click the last measure to be played before jumping to the 

coda. The Repeat Selection dialog box appears.

If the “To coda” mark doesn’t appear in the window: Click Create and type “To Coda #.” (You 
create the number sign [#] by pressing shift and typing a 3.) Set the font and style by clicking 
the Set Font button. Now select Replace ‘#’ With Repeat Mark in Target. In other words, when 
your “To Coda #” indication appears in the score, you want the # sign to be replaced by the 

repeat mark itself—in this case, the fi sign (“To Coda fi”). Click OK (or press enter). The “To 

Coda fi” mark now appears in the list of Text Expressions See REPEAT DESIGNER DIALOG 
BOX for more details on creating a text repeat.

• Double-click the “To Coda #” mark. The Repeat Assignment dialog box appears.

• Click Jump on Total Passes. Enter a number in the Total Passes text box. Enter a number 
in the Total Passes text box to designate on which repetition of this music the playback should 
jump to the coda sign. If this is a standard D.S. al Coda, in which the music up to the “To 
Coda” mark is played a total of two times, type 2 into the Total Passes text box.

• Click Jumper. Below the word Target, click Repeat. You selected Jumper because the 

words “To Coda fi” will make the playback jump elsewhere in the score. You selected Repeat 
because you want the playback to jump to a Mark-defined repeat (in this case the coda sign).

• In the Target text box, enter the Repeat number of the coda sign you created. This is the 
number you remembered when you placed the coda sign into the score.

Because you’ve specified that the playback should jump to the coda sign itself (instead of to a 
measure number), you can change your mind about the location of the coda sign in the score. 
You can delete it and put it in another measure—even a measure that precedes the “To Coda 

fi” marking—and Finale will still direct the playback to it correctly.

Tip: Check Individual Positioning to allow the coda sign to be moved independently between 
staves.
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• Click OK (or press enter). You return to the score, where the “To Coda fi” mark appears in 
every staff.

D.C.
Da Capo, or D.C., means “to the head.” It directs the player to return to the beginning of the score. 
“D.C. al Coda” and “D.C. al fine” instruct the player to then play to the To Coda marking or to the 
end of the piece, respectively.

In Finale, the D.C. marking and its variants are a type of repeat indication called a text repeat, 
meaning that they function the way a repeat barline would (but require no repeat barline).

To place a “D.C” marking in the score
If you follow all of these steps, you’ll create a functional text repeat that actually directs the play-
back of your score to the beginning of the piece. If the D.C. marking doesn’t need to affect play-
back, follow only the first five steps.

• Click the Repeat Tool x, and click the last measure to be played before returning to 

the beginning of the piece. The Repeat Selection dialog box appears. If the D.C. marking 
already appears in the window, skip the next two steps.

• Click Create and type D.C. (or “D.C. al Coda,” or “D.C. al fine”). Set the type style by 
clicking Set Font.

• Click OK (or press enter). The marking now appears in the list of Text Repeats.

• Double-click the D.C. marking. The Repeat Assignment dialog box appears.

If you don’t need your D.C. marking to be functional for playback, simply click OK (or press 
enter) to return to the score, where the D.C. marking appears.

• Click Jump on Total Passes. Enter a number in the Total Passes text box. The number in 
the Total Passes text box designates on which repetition of this music the playback should 
jump to the beginning of the piece. That’s the number you enter into the Total Passes text box. 
If the playback should return to the first measure after playing the music only once (the usual 
situation), enter 1.

• Click Jumper. Below the word Target, click Measure. You selected Jumper because the 
D.C. marking will make the playback jump elsewhere in the score. You selected Measure 
because you want the playback to jump to a specific measure in the piece (in this case, mea-
sure 1).

• In the Target text box, enter the measure number to which you want the playback to 
jump (usually measure 1). 

Tip: Check Individual Positioning to allow the coda sign to be moved independently between 
staves.

• Click OK (or press enter). You return to the score, where the D.C. marking appears in every 
staff. (To hide the marking in a certain staff, click the Staff Tool; then double-click on the 
desired staff’s handle. In the dialog box that appears, click Endings and Text Repeats.)
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To move or delete the “D.C.” marking
If the marking doesn’t already display a handle, click the Repeat Tool and click the measure con-
taining it.

• To move the marking, drag its handle. To remove it, click the handle and then press 
delete. 

To create a functional “To Coda” marking and fi sign
See CODA.

D.S., D.S. al Coda
D.S., or Dal Segno, means “from the sign.” It directs the player to return to a spot earlier in the 
score that’s marked by the % symbol. If the marking says D.S. al Coda, then the player is supposed 
to play from the % to a “To Coda” marking, then jump to a coda section at the end of the music. 
See CODA.

 You can easily place D.S. markings into your score if you’re preparing your score for printout and 
not for playback; see “To place a “D.S.” marking into the score,” below.

With some additional steps, you can even make your D.S. markings functional—that is, they can 
actually control the way Finale plays back your score. 

When Finale reaches the D.S. marking during playback, it jumps back to the % sign…

…and repeats the music up to the To Coda marking, whereupon it jumps to the coda.

To place a % marking into the score
This marking may be purely graphic, or it may be a functional text repeat that actually directs the 
playback of your score.

• Click the Repeat Tool x. 

• Click the measure in which you want the % sign to appear. The Repeat Selection dialog box 
appears. If you’ve loaded a Text Repeat Library—or if the Maestro Font Default file is in 
place—you should see the % sign.

If you don’t see the marking: click Create; the Repeat Designer dialog box appears. Type a % 
symbol (shift-5); click Set Font to change the type style to Maestro 24-point. Click OK (or 
press enter) twice.

If you don’t need to make the % marking control playback, press enter one more time; you 
return to the score, where the marking is in place. Also see “REPEATS–To move, hide, or delete 
a text repeat.”

D.S. al CodaTo Coda fi
fiCoda%

D.S. al CodaTo Coda fi
fiCoda%
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If you want to define the % marking for playback, continue:

• Note the Repeat number of the % marking. This indicator appears at the top of the dialog 
box, in the form “Repeat: 1” (or whatever number Finale has assigned). You’ll need to remem-
ber this number for a moment.

• Click Mark. You’ve just defined this text repeat to be a mark—in other words, a marker to 
which other text repeats (“D.S.,” in this example) will direct playback.

Tip: Check Individual Positioning to allow the coda sign to be moved independently between 
staves.

• Click OK (or press enter). The % sign appears in all staves. See “REPEATS–To move, hide, or 
delete a text repeat.”

To place a “D.S.” marking into the score
If you’ve created a % symbol, you must now place the corresponding D.S. marking. Again, this 
marking may be purely graphic, or it may be a functional text repeat that actually directs playback 
of your score to the measure containing the % sign.

• Click the Repeat Tool x. Click the last measure to be played before jumping to the 

segno. The Repeat Selection dialog box appears.

If you don’t see the D.S. marking in the window: Click Create and type “D.S.” (or D.S. al 
Fine, or D. S. al Coda). Click OK. The D.S. marking now appears in the list of Text Repeats.

• Double-click the D.S. marking. The Repeat Assignment dialog box appears.

If you don’t need to make the marking control playback, press enter one more time; you return 
to the score, where the marking is in place. Also see “To move, hide, or delete a text repeat.”

If you want to define the D.S. marking for playback, continue:

• Click Jump on Total Passes. Enter a number in the Total Passes text box. This number 
designates on which repetition of the music the playback should jump to the % sign. If this is a 
standard D.S., in which the music up to the D.S. marking is played once, type 1 into the Total 
Passes text box.

• Click Jumper. Below the word Target, click Repeat. You selected Jumper because the 
“D.S.” marking will make the playback jump elsewhere in the score. You selected Repeat 
because you want the playback to jump to another repeat mark (in this case the % sign), not 
necessarily a specific measure. 

• In the Target text box, enter the Repeat number of the % sign you created. This is the 
number you remembered when you placed the % sign into the score (see “TO PLACE A % 
MARKING INTO THE SCORE.”

Because you’ve specified that the playback should jump to the % itself (instead of specifying a 
measure number), you can change your mind about the location of the % sign in the score. You 
can delete it and put it into another measure, and Finale will still direct the playback to it cor-
rectly.

Tip: Check Individual Positioning to allow the D.S. sign to be moved independently between 
staves.
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• Click OK (or press enter). You return to the score, where the D.S. marking appears in every 
staff. See “REPEATS–To move, hide, or delete a text repeat.”

Measure repeat signs
The measure repeat symbol (‘), often used in rhythm parts, indicates that the measure in which it 
appears is to be a repetition of the previous measure. See also NUMBER REPEATED MEASURES 
PLUG-IN to place a number over each repeated measure.

To create a measure repeat sign

• Click the Staff Tool s and select the measures you want to contain measure repeat 

signs. See SELECTING MUSIC for some region-selecting shortcuts.

• From the Staff Menu, choose Apply Staff Styles. The Apply Staff Styles dialog box appears.

• Select either One-Bar Repeat(s) or Two-Bar Repeat(s). Click OK. Finale hides all the 
music in all layers, and replaces it with these measure repeat marks.

To restore the music, choose the measures again, choose Clear Staff Styles from the Staff 
Menu.

You can edit the properties of the staff styles; see STAFF STYLES DIALOG BOX for more detail. 

If you need additional control over these symbols—if you don’t want the symbol centered in 
the measure, for example—you can also insert a measure repeat symbol as an expression. See 
EXPRESSIONS.

Mid-Measure Repeats
To create the illusion of a mid-measure repeat, you’ll need to divide the current measure into two. 
For example, if you are in 4/4 and want the repeat to be after beat two, you will want to set this up 
as two 2/4 measures.

• Click the Measure Tool z. Click on the measure where you want the repeat.

• From the Measure Menu, choose Insert.

• Double-click on the new measure. The Measure Attributes dialog box appears.

• From the Time Signature drop-down list, choose Always Hide. 

• Click OK (or press enter). Repeat for the old or second half of the measure.

• Click the Time Signature Tool d, and click the new or first half of the measure. The 

Time Signature dialog box appears.

• Click the top scroll bar left until the window displays 2/4 time. Set the Measure Region to 
include the new and old measures.

• Click Options. The dialog box expands.
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• Click the top scroll bar right until the window displays 4/4 time. Check the Use a Differ-
ent Time Signature for Display.

• Click OK (or press enter)

• Continue with adding your repeat. See REPEATS (BARLINES AND TEXT INDICATIONS) for 
instructions.
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